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Introduction

Welcome to CareLink® iPro® Therapy Management Software for Diabetes

Thank you for your trust in Medtronic products and services.

• This User Guide provides the information that you need for setting up and using the CareLink

iPro Therapy Management Software for Diabetes.

• You will find a page like this at the beginning of each chapter. This page gives you a basic

overview of that chapter, and the steps you will take to complete each task.
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CareLink iPro Therapy Management Software

CareLink iPro Therapy Management Software for Diabetes, MMT-7340 (CareLink iPro software), is a

Web-based system designed to generate reports and store data.

The iPro2 digital recorder, MMT-7741 (iPro2 recorder), collects and stores data from a glucose

sensor. The data can be uploaded into CareLink iPro Therapy Management Software for Diabetes.

The iPro2 recorder can collect up to seven 24-hour periods of data, after which it shuts off

automatically.

Indications for use

CareLink iPro software is intended for use by health care professionals, for the purpose of analyzing

and displaying uploaded data. This information is intended to supplement, not replace, blood

glucose information obtained using standard home glucose monitoring devices. The information

may allow identification of patterns of glucose-level excursions above and below a desired range,

facilitating therapy adjustments, which may minimize these excursions.

Contraindications

None known.

Meters supported by CareLink iPro software for uploading

Data from the following blood glucose meters can be uploaded to CareLink iPro software. You will

need a meter cable as supplied by the meter manufacturer. Meter cables are not supplied as part

of the iPro2 system.

If a patient uses a meter that is not listed here, you can manually enter the BG meter readings into

CareLink iPro software.

Manufacturer Blood glucose meters+ ++

Ascensia Diabetes Care
(formerly the Diabetes Care business of Bayer HealthCare)

• CONTOUR®

• CONTOUR®NEXT

• CONTOUR®NEXT EZ

• CONTOUR®NEXT LINK

• CONTOUR®NEXT USB

• CONTOUR®USB

• BREEZE®

• BREEZE®2

LifeScan

• OneTouch® Ultra®

• OneTouch® Ultra® 2

• OneTouch® UltraLink™

• OneTouch® UltraSmart®

• OneTouch® UltraMini™
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Manufacturer Blood glucose meters+ ++

Abbott • Precision Xtra®

Roche

• ACCU-CHEK® Aviva +++

• ACCU-CHEK® Compact Plus +++

• ACCU-CHEK® Nano +++

+ To upload a meter on a Mac®, you must have the right cable and software driver. For details, see Setup for
uploading your meter on Mac on page 16.

++ At the time of this publication, some of the meter manufacturers do not provide a USB device driver for
uploading to Windows® 7, 8, 8.1, and 10 (32-bit and 64-bit). If your computer is running one of these operating
systems, you can only upload this device using the manufacturer's serial cable (not the USB device driver).

+++ The manufacturer of this device provides two types of cables: USB and serial. CareLink iPro software supports
the serial cable only.

Computer system requirements

Computers running CareLink iPro software must have the following software installed.

• Operating system:

- Microsoft® Windows® 7 Ultimate, 32-bit or 64-bit

- Microsoft® Windows® 8 Enterprise, 32-bit or 64-bit, from the desktop only.

- Microsoft® Windows® 8.1 Enterprise, 32-bit or 64-bit, from the desktop only.

- Microsoft® Windows® 10 Home, 32-bit or 64-bit, from the desktop only.

- Mac OS® 10.10 (Yosemite)

- Mac OS® 10.11 (El Capitan)

• Internet browser:

NOTE: On Windows 8 and 8.1, from the Start screen, click the Desktop tile and make sure
you are viewing the desktop before you open your browser.

- On Windows only: Microsoft® Internet Explorer® 8, 9, 10, or 11, 32-bit or 64-bit

- Mozilla® Firefox® 38

- On Mac OS only: Apple® Safari® 8 or 9

• Oracle® Java™ 7 or greater

• Adobe® Reader 5.0 or greater

• (Windows only) USB device drivers for meters that use a USB cable to connect to the computer

for uploading data. For more information, see the instructions provided by the meter

manufacturer.

NOTE: Some meter manufacturers may not provide a USB device driver for uploading to
Windows 7, 8, 8.1, and 10 (32-bit and 64-bit).  If your computer is running one of these

operating systems, you may need to use the manufacturer's serial cable.
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CareLink iPro software does not support USB uploads for all meters. See Meters supported by

CareLink iPro software for uploading on page 2 for details.

• (Mac OS only) Serial port driver for uploading blood glucose meters. For details, see Setup for

uploading your meter on Mac on page 16.
 
Computers running CareLink iPro software must also be compliant with IEC 60950-1 or an equivalent

safety standard.

Assistance

If you need help, contact one of the following resources:

Support Contact information

24 Hour HelpLine, Advanced Software Support

Monday through Friday, 5 a.m. to 5 p.m. (PST)

800 646 4633

818 576 5555

Medtronic Diabetes Web site www.medtronicdiabetes.com
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One-time CareLink iPro software and
computer setup

Key Notes:

• Do not connect the Dock to the computer until specifically told to do so in this procedure. If

you connect the Dock before the iPro2 Dock driver is installed, it may prevent the iPro2 Dock

driver from installing properly.

• You may need to perform a setup task on each computer that will be used for uploading sensor

data from an iPro2 recorder.

• Usernames for CareLink iPro software must be unique among all clinics in the system, not just

your clinic.

• Choose at least two people to be administrative users. One of them should complete the

CareLink iPro software setup for the clinic.
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Register clinic and create administrative user

When you access CareLink iPro software for the first time, you will be guided through a process to

register your clinic and create an administrative user. The administrative user is the person who will

create, add, and delete user accounts for the rest of the clinic's staff.

TM

CAUTION: Choose one person to be the first administrator for your clinic and register your
clinic only once using the Register Clinic  link. Do not create more than one clinic account for
your clinic. If each user registers another clinic, then the patient records will be divided into
separate clinic accounts and will not be accessible to all users.

1 On the computer, open your Internet browser and go to http://www.carelinkipro.com.

NOTE: On Windows 8 and 8.1, from the Start screen, click the Desktop tile and make sure
you are viewing the desktop before you open your browser.

If you have any trouble accessing the CareLink iPro software, check your web browser settings

to verify that JavaScript and SSL 3.0 are enabled. See Required Internet browser settings on

page 13  for additional information. If you still cannot access the website, check with your

network administrator to find out if your Internet access is restricted.

2 If necessary, click Change country/language,  and follow the on-screen instructions.

3 Click the Register Clinic  link near the bottom of the screen and follow the on-screen

instructions.

4 When prompted, enter the identifying information for your clinic, and click Continue.

5 When prompted, enter the identifying information for your administrative user account (also

known as Admin), and click Continue.
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You will sign in with this Admin user account to create user accounts for other users at the

clinic.

6 Click Finish  to return to the Sign-in screen.

Sign in

1 Go to http://www.carelinkipro.com. If you just registered the clinic, you will already be at this

web site.

2 Enter your username and password, and click Sign in.

The Home tab for your clinic appears. The clinic name and clinic ID will be at the top of the

screen. The clinic ID is randomly generated by the system. Your clinic’s Patient List will be in

the middle of the screen, showing one sample patient record. There will be no other patients

listed until you have conducted studies using an iPro2 recorder.

If you want to sign out of CareLink iPro software, click Sign out  near the top right corner of

your screen.

Create user accounts

Each staff member who might upload data from an iPro2 recorder or a blood glucose meter, enter

Logbook data, or review or print reports, will need a CareLink iPro software user account.

Any user with administrative privileges, also known as an Admin user, can add and delete user

accounts. An Admin user can also access a user account to change the password or other

information in the user account.

It is a good idea to give administrative privileges to at least two users. Having two Admin users

means that the clinic does not have to rely on only one person for things like setting up new user

accounts, or removing users when they no longer need access. As staff changes at a clinic, make

sure that two or more staff members have administrative privileges.

1 Get a list of names and email addresses for staff members who need CareLink iPro software

user accounts.

2 In the Clinic Settings tab, click Users.  The existing user accounts are displayed.
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If you are not logged in as an Admin user, you will not see the Users tab.

3 Click the Create new user  button. The Create New User screen appears.

4 Enter the required information about the user.

5 If you want this user to have permission to manage user accounts, select the Administrative

Privileges check box.

Important:  Always make sure that at least two people have administrative privileges. If an

Admin user leaves the clinic, add a new one.

6 Click Save.

NOTE: Usernames for CareLink iPro software must be unique among all clinics in the
system, not just your clinic. If the username you entered is not available, the system
informs you that you must try a different username.

7 Make a note of the username and password so that you can provide them to the user. He or

she will need this information to sign in and select a new password.

Repeat this procedure for each user account that you need to create.

Set clinic report settings

The Clinic Report Settings are the default settings for each new patient record. They are like a

template for new patient records.

xxxxxxx xxxxx xxxxxx xxxxxxx xxxxx 

xxxx

xxxx

xxxx xxxx xxxxxx xxxx xxxxxxx

xxxxxxx xxxxx xxxxxx xxxxx xxxxx                                      xxxx 

xxxx

xxxx

xxxx xxxx xxxxxx xxxx

xxx

xxx

xxx xxx xxx xx                   xxxxxx

xxxxxxxx  xxxx xx       xxx                 xxx          xxxxx xxx                      xxxx xxx                x

xxxx        xxx                 xxx          

xxxxxxxx  xxxx xx       xxx                 xxx          xxxxx xxx                      xxxx xxx                x

xxxx        xxx                 xxx          

xxxxxxxx  xxxx xx       xxx                 xxx          xxxxx xxx                      xxxx xxx                x

NOTE: Changing the Clinic Report Settings does not affect any existing patient studies or

reports.

If a particular patient has unique needs, you will be able to override these settings later for individual

patients as needed.

1 Click the Clinic Settings  tab. The Report Settings for the clinic are displayed.

If you do not see the Clinic Settings  tab, click the Home tab. You should now see the Clinic

Settings  tab.

2 In Report Settings,  set the General Report Settings and the Analysis Reports Settings.
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For more information about these settings, see the following two sections, or click the help icon

 in CareLink iPro software for each section.

3 When you are finished, click Save.

The clinic settings take effect for all new patients added to the system after you change the

settings. Previously added patients and previously generated reports are not affected.

For more details about how to set different report settings for a particular patient, see Patient

Report Settings on page 31.

General Report Settings

The General Report Settings determine how glucose and time information will be displayed in

patient reports.

• Glucose Target Range  fields: Select a glucose target range to use in the reports.

- For High value: Enter the glucose measurement that is considered to be the upper limit

of euglycemia (target) for this patient. The system uses the High value in reports to show

the range that is above the euglycemic or glucose target range.

- For Low value:  Enter the glucose measurement that is considered to be the lower limit of

euglycemia (target) for this patient. The system uses the Low value in reports to show the

range that is below the euglycemic or glucose target range.

• Extreme Glucose Range  fields: Select an extreme glucose range to use in the reports.

- For Extreme High:  Enter the glucose measurement that is considered to be extreme

hyperglycemia for this patient. The system uses the Extreme High Glucose Range in reports

to show the range that is above the high glucose range.

- For Extreme Low:  Enter the glucose measurement that is considered to be extreme

hypoglycemia for this patient. The system uses the Extreme Low Glucose Range in reports

to show the range that is below the low glucose range.

• Glucose Units:  Select the appropriate units for reporting glucose amounts (mg/dL or mmol/L).

• Time Display:  Select 12 hour or 24 hour time display format.

Analysis Reports Settings

The Glucose Target Range fields specify a Before Meal and After Meal glucose target range for each

of the three meal periods. The overnight periods of Evening and Sleeping contain a single target

range. You may enter a high value and low value for a target range according to the following rules.

• If you have selected mg/dL as the Glucose Units:

- The format for entering the low value for the target range is xxx (for example, 123). The

low value can range from at least 10 higher than the extreme low value to 140 mg/dL.

- The format for entering the high value for the target range is xxx (for example, 123). The

high value can range from 80 to 20 mg/dL lower than the extreme high value.

• If you have selected mmol/L as the Glucose Units:
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- The format for entering the low value for the target range is xx.x (for example, 12.3). The

low value can range from at least 0.6 higher than the extreme low value to 7.8 mmol/L.

- The format for entering the high value for the target range is xx.x (for example, 12.3). The

high value can range from 4.4 to 1.1 mmol/L lower than the extreme high value.
 
Time periods are used to identify which meal to associate with each meal marker. For example, if

the breakfast time period is set from 6:00 a.m. to 10:00 a.m. and lunch is set from 10:00 a.m. to 3:00

p.m., then a meal marker entered for 9:30 a.m. would be interpreted as a breakfast marker, and a

meal marker entered for 12:30 p.m. would be interpreted as a lunch marker.

The duration of each period must be at least 0.5 hours. The end time of a period can be different

from the start time of the next period, so gaps between periods may exist. The one exception to

this rule is that the end of Evening must be the same as the start of Sleeping.

A post-meal analysis is used to generate statistics from data collected following a meal. The Post-

Meal Analysis window can extend up to 4.0 hours after a meal event. The duration of the analysis

window must be at least 0.5 hours. The start time can range from 0.0 to 3.5 and the end time can

range from 0.5 to 4.0.

Set up computers for uploading

CareLink iPro software needs Java and certain hardware drivers to be installed, in order to upload

patient data. You also need Adobe Reader installed in order to view reports.

Before you begin, please note:

• Some operating systems may require that you have administrative privileges for the computers

in the office to complete this task. Ask a user with administrative privileges, such as your network

administrator, to sign in to each computer to allow the installation of required software

components.

• You must do this for each computer that may be used to upload sensor data from an iPro2

recorder using the Dock.

• If the computer is running Windows 7, Windows 8, Windows 8.1, or Windows 10, see Required

settings for Windows users on page 12  before completing this procedure.
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• If you are using a Mac® computer, you may need to get a new cable and install a software driver

so that you can upload your blood glucose meter. For details, see Setup for uploading your meter

on Mac on page 16.

CAUTION: Do not connect the Dock to the computer until specifically told to do so in this
procedure. If you connect the Dock before the iPro2 Dock driver is installed, you may see the
Windows Found New Hardware Wizard. Close the wizard screen or click Cancel, and do not

follow the instructions in the Wizard. It may prevent the iPro2 Dock driver from installing
properly.

1 Sign in to CareLink iPro software.

2 On the Home screen, click Patient, Sample M.  in the Patient List. If you already have a list of

patients, type Sample Patient in the Search  box to find the sample patient in the Patient

List, and click on it to select it.

3 Click Open patient.

A sample patient record is displayed.

4 Click the Upload iPro2 button.

If you see a message asking if you are sure you want to upload another study for the patient,

click Yes.

If you see a message at any time that you do not have permission to install software, contact

your network administrator.

5 If the computer does not have the necessary version of Java installed, a screen prompting you

to install Java is displayed.

a. Click Download and Install the Java™ Plug-in to continue. The link will navigate to the

Oracle Java website.

b. Follow the on-screen instructions to install Java. Some operating systems may require that

you have Administrative privileges in order to install the Java plug-in.

c. If you see any security questions in the information bar (above the Medtronic logo) or

security pop-ups, click Allow or Continue.

Also, check the task bar at the bottom of your screen for new items. The Java installation

pop-up may sometimes be hidden behind your current browser window.

NOTE: In the Java installation screen, you may see a check box asking if you want to install
a toolbar. If you do not want to add any toolbars to your Internet browser, make sure to
de-select that option by clicking the check box.

6 Next, CareLink iPro software will install the SerialPort and Dock USB drivers. Follow the on-screen

instructions to install these components.

After all items have been successfully installed, the screen will say, Prepare iPro2 Recorder for
upload.
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a. Connect the iPro2 Dock to the computer using the USB cable.

You should see a small pop-up at the bottom of your screen that says, Medtronic iPro2

Dock.  This means that the driver for the Dock is successfully installed.

b. Click Cancel to cancel the demonstration upload.

7 Verify that Adobe Reader is installed on the computer. If Adobe Reader is not installed, go to

http://www.adobe.com/reader to download and install Adobe Reader, so that you will be able

to open and view reports.

8 Click the Home  tab to close the sample patient record.

The computer is now ready for you to upload data.

9 Repeat this process on each computer that may be used to upload sensor data from an iPro2

recorder using the Dock. On each computer that will be used to view reports only, make sure

that Adobe Reader is installed.

Required settings for Windows users

If your computer is running the Windows operating system, there are some additional steps to

follow in order to prepare your computer for uploading device data.

1 Make sure that User Account Control is enabled. By default, User Account Control is already

enabled, so it is likely that you do not have to enable it. For details, please see the Microsoft

documentation.

2 Close Internet Explorer.

3 If you are using the Windows 7 operating system:

a. Navigate to Start > All Programs.

b. Right-click on the Internet Explorer menu item.

If you are using the Windows 8 or Windows 8.1 operating system:

a. From the Start screen, click the Desktop tile and make sure you are viewing the desktop.

b. Right-click on the Internet Explorer icon in the task bar.

c. In the menu that appears, right-click again on Internet Explorer.

If you are using the Windows 10 operating system:

a. Navigate to Start > All Apps > Windows Accessories.
b. Right-click on the Internet Explorer menu item.

4 Select Run as Administrator.

5 When the User Account Control window is displayed, click Allow or Yes.

NOTE: If you are not logged in as an administrator on your computer, you may be asked to
enter an administrator user's password.
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6 The system will now allow software components to be installed. Complete the procedure

described in Set up computers for uploading on page 10.

Required Internet browser settings

On all computers where you plan to use CareLink iPro software, your Internet browser must have

the following settings enabled:

• JavaScript

• Secure Sockets Layer (SSL) version 3.0, with 128-bit encryption

• Cookies

• Applets

• ActiveX

Enabling JavaScript

The software uses JavaScript to perform some of its functions. JavaScript is enabled by default for

most Internet browsers. If the JavaScript setting for your Internet browser is disabled, you need to

enable this setting in order to use the system.

Enabling JavaScript in Internet Explorer

Take the following steps if you need to enable JavaScript or want to check the setting.

1 From the Internet Explorer menu options, select Tools > Internet Options.  The Internet Options

page is displayed.

2 Click the Security  tab. The Security tab page is displayed.

3 Select the Internet  icon and click the Custom Level button. The Security Settings page is

displayed.

4 Use the scroll bar on the right of the Settings box to scroll down to Active scripting.

5 Underneath Active scripting, select Enable.

6 Click OK.

Enabling JavaScript in Firefox

Take the following steps if you need to enable JavaScript or want to check the setting.

1 From the Firefox menu options, select Tools > Options.  The Options page is displayed.

2 Click Content.

3 On the Content page, make sure that Enable JavaScript  is selected.

4 Click OK.
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Enabling Javascript in Safari

Take the following steps if you need to enable JavaScript or want to check the setting.

1 From the Safari menu options, click Preferences.

2 Click the Security  icon. The Security page is displayed.

3 Select the Enable JavaScript  check box.

4 Close the Preferences  window.

5 Close and restart Safari.

Secure Sockets Layer (SSL) and encryption

Secure Sockets Layer (SSL) refers to a security protocol designed to protect your Web browser

sessions. The system requires your browser to be enabled for SSL Version 3. It also requires support

for 128-bit SSL encryption.

The minimum Internet browser version required by the system has 128-bit encryption built in. So,

if you are receiving an error message about your browser configuration, and it shows that you have

an SSL setting of less than 128-bit key, you probably need to upgrade to the latest version of your

browser.

First take the following steps to check the SSL on the current version of your browser and make

sure it is enabled.

Enabling SSL in Internet Explorer

1 From the Internet Explorer menu options, select Help > About Internet Explorer.

2 The amount listed after Cipher Strength is the SSL. If this is less than 128-bit, you need to

upgrade your Internet Explorer. See the procedure that follows.

3 Click OK.

4 After verifying that you have 128-bit encryption, select Tools > Internet Options from the

Internet Explorer menu options.

5 Click Advanced.

6 Scroll down the list and make sure that Use SSL 3.0 is selected.

7 Click OK.

Upgrading Internet Explorer

If you need to upgrade your Internet Explorer to the latest version, you can go to the Microsoft

Internet Explorer Web site at http://www.microsoft.com.

Follow the instructions provided by Microsoft to download and install the latest version of Internet

Explorer.
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Enabling SSL in Firefox

1 From the Firefox menu options, select Tools > Options.  The Options page is displayed.

2 Click Advanced.

3 On the Advanced page, click the Encryption tab.

4 On the Encryption tab, make sure that Use SSL 3.0 is selected.

5 Click OK.

Upgrading Firefox

If you need to upgrade your Firefox to the latest version, you can go to the Mozilla website at http://

www.mozilla.com.

Follow the instructions provided by Mozilla to download and install the latest version of Firefox.

Setting Internet Explorer for secure browsing

To keep your therapy management information private, always remember to log off of the system

by clicking the Log-Off  hyperlink.

In addition, if you want to prevent others from seeing that you visited this therapy management

website, you can disable the Back button in your Internet browser. The following instructions

describe how to disable the Back button in Internet Explorer.

NOTE: If you disable the Back button, it will be disabled for all websites that you visit.

1 Select Tools > Internet Options from the Internet Explorer main menu.

2 Click the Advanced tab.

3 Scroll down to the Security check items.

4 Make sure there is a check mark in the box next to “Do not save encrypted pages to disk.” (If

need be, click in the box to place a check mark in it.)

5 Click OK.

Setting Safari for secure browsing

To keep your therapy management information private, always remember to log off of the system

by clicking the Log-Off  hyperlink.

In addition, if you want to prevent others from seeing that you visited this therapy management

website, you can enable the Private Browsing mode in Safari so that all of your activity will be

removed each time you close Safari.

1 In your Safari browser window, select Private Browsing  under the Safari menu.
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A message is displayed asking if you want to turn on private browsing.

2 Click OK.

Setup for uploading your meter on Mac

If you want to upload a supported Ascensia meter (BREEZE®, CONTOUR®, or CONTOUR®NEXT family

of products) that has a USB connector on a Mac computer, you can select your meter and complete

the upload procedure. No additional setup is needed.

If you want to upload any other blood glucose meter on a Mac computer, please follow the

instructions below for your meter and operating system version. After you have set up your

computer for uploading your meter, you do not need to complete these steps again.

NOTE: Medtronic Diabetes cannot guarantee the availability of cables, adapters, and software
drivers from other manufacturers. Websites of other manufacturers may change.

For a list of supported meters, see Meters supported by CareLink iPro software for uploading on page 2.

Setup of LifeScan meters on Mac on page 16

Setup for all other meters or ComLink on Mac on page 17

Setup of LifeScan meters on Mac

The setup for uploading your LifeScan meter depends on the version of your operating system.

Please refer to the instructions for your version.

Setup for LifeScan meters on Mac OS 10.10 or 10.11

1 Get a serial cable from the meter manufacturer. You will need a serial cable because at the time

of this publication, the USB cable from LifeScan does not work with Mac OS 10.10 or 10.11.

2 Get a USB-to-serial adapter that is compatible with your Mac operating system, such as the

USBGEAR™ RS-232 Serial Adapter DB-9 Male. You will need a USB-to-serial adapter because Mac

computers do not have serial ports.

Important: If you have a different adapter, you should install the driver provided by the
adapter manufacturer. Do not continue with these driver installation steps.
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3 If you have the USBGEAR RS-232 Serial Adapter, click the following hyperlink to install the

software driver: http://www.ftdichip.com/Drivers/VCP/MacOSX/

FTDIUSBSerialDriver_v2_2_18.dmg

Please note that this website is in English only.

Select the driver called FTDIUSBSerialDriver_10_4_10_5_10_6_10_7 and follow the on-screen

instructions.

4 When prompted, enter your Mac username and password. The username you enter must be an

Administrator on your computer.

5 Restart your computer when you are instructed to do so.

Setup for all other meters or ComLink on Mac

1 Get a serial cable from the meter manufacturer. You will need a serial cable because most meter

manufacturers that provide USB cables do not provide support for Macintosh computers.

2 Get a USB-to-serial adapter that is compatible with your Mac operating system, such as the

USBGEAR™ RS-232 Serial Adapter DB-9 Male. You will need a USB-to-serial adapter because Mac

computers do not have serial ports.

Important: If you have a different adapter, you should install the driver provided by the
adapter manufacturer. Do not continue with these driver installation steps.

3 If you have the USBGEAR RS-232 Serial Adapter, click the following hyperlink to install the

software driver: http://www.ftdichip.com/Drivers/VCP/MacOSX/

FTDIUSBSerialDriver_v2_2_18.dmg

Select the driver called FTDIUSBSerialDriver_10_4_10_5_10_6_10_7 and follow the on-screen

instructions.

4 When prompted, enter your Mac username and password. The username you enter must be an

Administrator on your computer.

5 Restart your computer when you are instructed to do so.
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Download and print resources

After you are finished with setting up CareLink iPro software for the clinic, you can click the

Resources  hyperlink in CareLink iPro software to download document resources such as Patient Log

Sheets, Clinic Equipment Log Sheets, and other useful materials.

For example, you can download a sample Patient Consent Form in Microsoft Word format. This form

allows you to easily create actual Patient Consent Forms that are appropriate for your office.

These resources are free from Medtronic for your use with your iPro2 system. Medtronic may

occasionally update these resources based on feedback from users like you.

User security advisory

Your safety and the privacy of your information are of highest importance to Medtronic. To help us

ensure that our CareLink iPro software products work correctly and securely, please consider these

good practices and precautions to help keep your computer system safe and secure:

• Use a supported operating system and browser. Even though CareLink iPro software may let

you proceed with an operating system or browser that is not validated, it is better to use one

of the fully supported configurations.

• The industry responds to newly discovered security issues with updates. Keep your PC or Mac

system up to date with the most current updates for your operating system, browser, plug-

ins, and Java run-time environment.

• Use a strong password. The most important factors are length and avoiding common spellings

of words. Some password vaults offer the ability to create very strong passwords and provide

them on demand.

• Do not disclose your password to anybody, except your trusted Care Partners.

• Medtronic Customer Service will never ask for your password. If you get a request to disclose

your password by email, please contact Customer Service immediately and do not reply to the

email.

• Refuse to provide your password and request to speak to a manager immediately if any

Medtronic Customer Service representative asks for your password.

• Change your password immediately if you think your password has been compromised.

• It is good practice to change your password every 3-6 months.

• If you suspect your account may have been accessed by somebody you have not shared your

password with, please contact Customer Service immediately.

• Use reputable security software on your PC or Mac that provides protection against viruses,

“adware” and other forms of malicious software (“malware”).
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• Take advantage of “software firewall” features in your security software as added protection for

your PC or Mac.

• Consult with your Internet Service Provider about security for your access point (typically your

modem) and router. Additional protection, such as firewall features, may be available to you.

• Be aware that many websites and emails are malicious and are designed to compromise your

computer system. Always be careful about opening email from somebody you do not know, or

going to websites from links in emails.

• Use the strongest settings on your PC or Mac security software that you can to help guard

against accidental contact with malicious software.
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3

Entering data into CareLink iPro software

Key Notes:

• You will need to open or create a patient record on your internet browser in order to enter

data for that particular patient.

• You can upload patient meter data directly into CareLink iPro software. The meter data will be

automatically added into the CareLink iPro Logbook. Do not change the time or date on the

meter before uploading.

• Enter any additional data that a patient may have recorded on a log sheet into the CareLink

iPro Logbook. You may exclude BG meter readings or remove manually entered patient data

from the Logbook if necessary.
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Opening the patient record

1 On the computer, open your Internet browser and go to http://www.carelinkipro.com.

2 Sign in to CareLink iPro software using your username and password.

If you are already signed in, click the Home tab.

3 Type any of the following into the Search box to find the patient record:

- First name

- Last name

- Patient ID

- Date of birth

As you type, the Patient List displays matching patient records from previous studies.

4 When you see the patient in the list, select the patient and click the Open patient  button. You

can also double-click the patient in the list.

If your patient is using the iPro2 myLog app, in some cases you will see a screen confirming

the information entered into the app. The patient record will have been created, and the patient

name will be bold, indicating the information needs to be confirmed.

5 If you do not see the patient in the Patient List, click the New patient button to add the patient

to CareLink iPro software.

The Create new patient record screen is displayed.

CAUTION: Make sure to thoroughly search for the patient in CareLink iPro software before
adding a new patient record. If your clinic has already conducted a study for the patient,

open the existing patient record. Avoid creating multiple records for one patient, as this
will make the patient's data more difficult to find in the system.

6 Enter the identifying information for the patient. The patient’s name or patient ID that you enter

will be displayed on reports. Click Save when you are finished.

You can modify the patient information later by clicking the Edit patient information  link on

the patient's record.

Uploading blood glucose meter data

If the patient has been using a supported meter (see Meters supported by CareLink iPro software for

uploading on page 2), you can upload meter data directly into CareLink iPro software. The

software automatically puts the BG meter readings into the patient’s CareLink iPro Logbook. If the

patient entered events on the meter, some of these events will also be automatically uploaded

into the Logbook.
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CareLink iPro software will compare the time and date of the computer to the time and date of

the meter. If the meter time is incorrect, CareLink iPro software will use the computer's time to

automatically correct the BG meter reading times. Do not change the time or date on the meter

before uploading.

NOTE: If you have uploaded a study from an iPro2 recorder and there has been a time change,

contact the 24 Hour HelpLine for assistance in uploading the meter.

If the patient has been using a meter that is not listed in Meters supported by CareLink iPro

software for uploading on page 2,  you can enter BG meter readings manually. See Entering Patient

Log Sheet data on page 22  for instructions.

NOTE: You can upload only one meter per study.

1 If you have just finished uploading a study from the iPro2 recorder, you will be prompted to

select the patient’s meter after you click Continue.

You can also choose to enter BG meter readings manually using the Logbook. For details, see

Entering Patient Log Sheet data on page 22.

2 Follow the on-screen instructions.

3 When prompted, connect the meter to the computer using the appropriate cable (supplied by

the meter manufacturer).

CareLink iPro software tells you when the upload is successfully completed.

4 Disconnect the meter from the computer.

Entering Patient Log Sheet data

The Logbook screen in CareLink iPro software allows you to manually enter BG meter readings and

other events that the patient recorded on a Patient Log Sheet, such as meals, medication,

exercise, or other. You are able to include details of an event, such as the intensity of the exercise

or the size of the meal.
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You can exclude BG meter readings from being used for sensor calibration, and update or remove

manually entered events from the patient data if necessary.
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Opening the Logbook

If you have just finished uploading the patient’s meter, click Continue  to open the Logbook. You

can also open the Logbook by clicking the Open Logbook  button found on the patient record

screen.

If your patient is using the iPro2 myLog app, the events entered in the app automatically

populate into the Logbook when it is opened.

Adding Logbook entries

CareLink iPro software calibrates the sensor glucose data using the patient’s BG meter readings

that are uploaded from a meter or the iPro2 myLog app, or entered manually. If you cannot

upload data from the patient’s meter, then you must enter BG meter readings manually in the

Logbook.

1 Click the Add  button. A small window appears, where you can make a Logbook entry.

2 Enter the date and time. If the entry is a BG meter reading, enter the BG value. If the entry is

an event, select the appropriate check box or button for the event.

If the patient recorded more than one entry at the same time, such as a meal and a BG meter

reading, you must enter them both in one entry.

NOTE: If a daylight saving time change occurred during the study, or after the study but
before you are entering the data, enter all log sheet events that occurred before the time
change according to the new time.

3 Click Enter.  The information goes into the Logbook, but a new empty data entry window stays

open and is ready for the next entry.

4 When you are finished adding Logbook entries, click the X in the upper right corner of the data

entry window to close it.

5 If you are finished using the Logbook, click Continue  to return to the patient's main record

screen.
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NOTE: Only BG meter readings between 40 and 400 mg/dL (2.2 and 22.2 mmol/L) will be

used for calibration.

Excluding BG meter readings

You can tell CareLink iPro software to exclude a BG meter reading so that it is not used to

calibrate the sensor glucose data and is not included in the reports.

For example, if the patient allowed a different person to use the meter, or if a control solution

was used but the BG meter reading was not marked as a control reading in the meter, you would

not want these BG meter readings to be used for sensor calibration.

1 In the patient’s Logbook screen, click the Exclude  check box for each BG entry that you want

to exclude from the calibration.

2 If you are finished using the Logbook, click Continue  to return to the patient’s main record

screen. The reports are regenerated automatically.

When you view the patient’s reports, the BG meter readings that you excluded will not be

shown, and they will not affect the sensor information in the reports.

Editing Logbook entries

You can edit Logbook entries that have been entered manually. You are also able to hover over

the icons in the Logbook to see additional details. Events that were uploaded from a meter

cannot be edited; you can only exclude them from calibration and reports.

1 In the patient’s Logbook screen, click on a Logbook entry to highlight it, and then click the Edit

button. The Logbook entry opens in a small window.

2 Edit the information as needed, and click Enter.

3 If you are finished using the Logbook, click Continue  to return to the patient’s main record

screen. The reports are regenerated automatically.

Removing Logbook entries

You may sometimes want to remove events from the Logbook so that they do not show up on

the patient’s reports. You can remove Logbook entries that have been entered manually. Events

that were uploaded from a meter cannot be removed. They can only be excluded from calibration

and reports.

1 In the patient’s Logbook screen, click on a Logbook entry to highlight it, and then click the

Remove button.

2 A small window appears, asking you to confirm that you want to remove the item. Click

Remove.  The event no longer appears in the Logbook. When you view the patient’s reports,

the events that you removed will not be shown on the reports.
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3 If you are finished using the Logbook, click Continue  to return to the patient’s main record

screen. The reports are regenerated automatically.

Sorting the Logbook entries

You can sort the events in the Logbook by clicking on a column heading. This can help you find

items in the Logbook. It does not affect how patient data appears on reports.

You may need to click the column heading twice to reverse the sort order.
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4

CareLink iPro reports

Key Notes:

• You can modify a patient's Report Settings, such as the glucose target range and meal

periods, and re-generate reports from a study.

• Reports show up to seven 24-hour periods of study data.

• The reports are created in PDF format, so they can easily be stored electronically or printed.
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Viewing and printing patient reports

After uploading and entering all of a patient’s study data into CareLink iPro software, you have two

options for viewing the patient’s reports:

• View and print the reports individually

• Print all reports

1 If you are not already viewing the patient record, go to the Home tab and use the Search box

to find the patient record.

If you need more instructions on how to find a patient record, see Opening the patient record

on page 21.

2 On the patient record screen, you can find the dates for all of the studies conducted for this

patient. The most recent study is displayed first. You may need to scroll down to find older

studies.

3 When you find the study you want, click the name of the report you want to view, or click Print

all  to print all of the main reports.

If you click on a single report, a new window or tab opens in your browser to display the report.

If you click Print all,  a new window or tab opens in your browser, with all of the reports in a

single PDF document.

4 To print, use the print functions that are set up on the computer. For example, you may need

to click a printer icon, or you may need to select File > Print.

Tips for successful report generation

• Use the Logbook to exclude BG meter readings that do not accurately reflect the patient's blood

glucose, such as:

- BG meter readings from someone other than the patient

- BG meter readings from a control solution

- BG meter readings that were taken before the patient changed the meter's time or date. If

the patient changed the time on the meter during the study, first exclude all BG meter

readings before the time change. Then, use information from the Patient Log Sheets to

manually enter the BG meter readings at the correct times into the Logbook in CareLink

iPro software.

These bad BG meter readings can cause calibration errors, which may result in gaps in the sensor

plot on reports. Excluding these bad BG meter readings will often eliminate data gaps.

• Keep in mind that you need BG meter readings within 12 hours of each other in order to avoid

data gaps.
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• Modify a patient's Report Settings to change the target range for blood glucose, the patient's

meal periods, or other settings.

• There are a few instances in which information collected in iPro2 myLog app will not show up

on reports. If your patient is connected to a wearable device, for example wristbands or

smartwatches, any carb data that is blank or zero in the app will not show up in reports. If your

patient is connected to a wearable device and has a BG reading outside of the range of 20 to

600 mg/dL, that BG reading will not show up on reports. It does not appear in CareLink, and

cannot be used for calibrations. Also, although your patient is able to enter specific medication

names into iPro 2 myLog app, those details will not show up on reports. Additionally, your

patient is able to input into iPro2 myLog app the type of meal consumed, for example a

snack. The reports will not capture what was selected in the "What meal?" box, but only show

a meal was consumed. Lastly, in the Blood Sugar section of the app, when entering a BG reading

your patient is able to input that a meal was consumed. That information is not captured in

reports. Only meals logged in the Meal section will show up on reports.

About reports

CareLink iPro reports show up to seven 24-hour periods of study data. The reports are created in

PDF format, so they can easily be stored electronically or printed. The five main reports are:

• Daily Overlay (one page) - provides an overlay of the sensor traces for each day on a single 24

hour graph, so that you can look for trends or excursions that occur around the same time each

day. This report also provides daily statistical information, including an Excursion Summary of

highs and lows, and Duration Distribution pie charts. The Duration Distribution charts show

what percent of each day the patient spent above, below, and within the target range.

• Overlay by Meal (two pages) - provides an overlay of the sensor traces from each day of the

study, broken down into meal and overnight periods. The meal overlay graphs are only created

if meal events are entered into the CareLink iPro Logbook. The patient's Report Settings, if

different from the clinic Report Settings, determine what the periods are. The sensor traces for

each day are overlaid, so that you can look for trends at certain times related to meal or

overnight periods. This report lines up glucose sensor traces before and after each meal and is

especially useful if patients eat meals at varying times each day.

• Daily Summary (two pages) - provides a summary of each full or partial 24-hour period of the

study, including both the sensor trace and events such as meals, medication, and exercise. The

report includes details of the events, for example the intensity of the exercise or the size of the

meal.

• Pattern Snapshot (one page) - provides a summary of daily glucose information and up to three

observed patterns. This report has three sections consisting of general statistics, observed

patterns and some possible causes, and an overlay graph.
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• Patient Notes - provides a summary of the event markers recorded in the system. This report

includes a chronological listing of all patient events for a given time period. Each event is

represented by a corresponding icon, and includes event details.

Optimal accuracy

CareLink iPro software automatically performs certain checks for optimal accuracy of the data in a

study. These checks are designed to help you become aware of any data that may be less than

optimal for making therapy decisions.

The system evaluates the accuracy of the data on a calendar day basis, from midnight to midnight

for each day that sensor glucose values are recorded. There are three measurements to determine

the accuracy of the data: number of valid calibrations, mean absolute difference percentage (MAD

%), and correlation.

Days that do not meet one of the thresholds are designated as Use Clinical Judgment.  This

designation appears in two places: on the Daily Overlay Report, and on the Daily Summary Report

for the individual day graph. On the Daily Overlay Report, those days that do not satisfy the criteria

are marked with an X  in the Designation row.

If the Designation area is blank for a certain day on the Daily Overlay Report, then the data for that

day passes all optimal accuracy criteria.

• MAD%:  the threshold for MAD% will vary depending on the range of BG meter values for the

calendar day. If the calendar day does not meet this threshold, it will be designated with an X

(Use Clinical Judgment).

If the BG meter reading range is greater than or equal to 100 mg/dL (or 5.6 mmol/L), then an

MAD% of 28.0 or less is considered optimal.

If the BG meter reading range is less than 100 mg/dL (or 5.6 mmol/L), then an MAD% of 18.0

or less is considered optimal.

• # Valid Calibrations:  3 or more is considered optimal. If there are less than 3 valid calibrations

in a calendar day, then that day does not meet this threshold and will be designated with an

X (Use Clinical Judgment). This commonly occurs on a partial day of sensor wear, such as the

last day of the study.

The system evaluates the accuracy of the sensor glucose values in comparison with the BG

meter readings used for the calibration. Each BG meter reading used for calibration is paired

with the corresponding sensor glucose value generated by the calibration algorithm at the same

point in time.

Not all BG meter readings used for calibration are considered valid for purposes of optimal

accuracy evaluation. If no other BG meter reading (used for calibration) exists within 12 hours

before or after a calibration, then the BG meter reading is not considered valid for purposes of

optimal accuracy determination.
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Only BG meter readings between 40 and 400 mg/dL (2.2 and 22.2 mmol/L) will be used for

calibration.

• Correlation:  0.79 or greater is considered optimal. If the Correlation is less than 0.79, then that

calendar day does not meet this threshold and will be designated with an X (Use Clinical

Judgment).

When the BG meter reading range is less than 100 mg/dL (or 5.6 mmol/L) or the number of

valid calibrations is less than 3, then the Correlation  is reported as N/A  and is not evaluated,

for purposes of optimal accuracy.

If the correlation is high (close to 1.0), but the MAD% is high, this can be due to a single outlying

BG meter reading. This would cause a Use Clinical Judgment designation.
 
There are also two other designations that can appear on the Daily Overlay Report: S: No Sensor
Data and C: No Calibration BG's.

• S: No Sensor Data: This designation occurs on a calendar day in which there is no sensor

data. Therefore, there are no sensor values on the reports for that day. The Daily Summary graph

for that day shows only BG meter readings plotted, if there are any, and no sensor data.

• C: No Calibration BG's:  This designation occurs on a calendar day in which there are sensor

values available, but there are no valid BG meter readings with which to calibrate the sensor

values. Sensor data that cannot be calibrated will be missing from the reports for that day.

Area under the curve (AUC)

Area under the curve (AUC) information appears in the Excursion Summary on the Daily Overlay

Report. AUC provides more insight into how much time the patient's glucose was high or low, as

well as the severity of excursions outside of the target range. A high AUC indicates more excursions

or more severe excursions. The closer that AUC is to zero, the more that the patient's glucose stayed

within the target range.

AUC calculations are reported in mg/dL per day (or mmol/L per day). The Daily Overlay Report

provides two AUC amounts for each day: AUC Above Limit  and AUC Below Limit.

• AUC Above Limit:  this statistic provides a relative indication of the overall extent and duration

of high glucose excursions over the entire day. The calculation is dependent on the patient

Glucose Target Range High setting. The High limit value is subtracted from each individual

sensor glucose value that exceeds the limit. The differences are summed and the sum total is

divided by the total number of sensor glucose values that exist for the day.

• AUC Below Limit: this statistic provides a relative indication of the overall extent and duration

of low glucose excursions over the entire day. The calculation is dependent on the patient

Glucose Target Range Low setting. Each individual sensor glucose value that exceeds the limit

is subtracted from the Low limit value. The differences are summed and the sum total is divided

by the total number of sensor glucose values that exist for the day.
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Patient Report Settings

When you first add a patient into CareLink iPro software, the patient's Report Settings are set based

on the current Clinic Report Settings that are defined on the Clinic Settings  tab. The Clinic Report

Settings are like a template for creating the Report Settings for each new patient. After a patient

record has been created, you can change the Report Settings for that patient's reports. 

For example, the patient’s meal periods may not match the default meal periods, which were defined

for your clinic in the Clinic Report Settings. Or, the target glucose range for the patient may be

different from the default range set in the Clinic Report Settings.

In these cases, you can modify a patient’s report settings manually.

• If you change the Patient Report Settings before generating reports, future reports will be

generated based on the changes you made.

• If you change the Report Settings after generating reports, you must choose whether you want

to apply the new settings to the most recent reports. You can also apply the new settings to

older studies. Existing study reports will not be updated automatically based on the new

settings.
 
After viewing the first reports you generate for a patient, you may decide to modify the Patient

Report Settings, and then generate the reports again based on the new settings.

Modifying Patient Report Settings

1 Click the Edit  link in the Patient Report Settings section of the patient record screen.

The patient’s General Report Settings and Analysis Reports Settings are displayed.

2 Change the settings as needed. For more information about the General Report Settings and

Analysis Reports Settings, see General Report Settings on page 9  or Analysis Reports Settings on

page 9.

3 Click Save.  A small window appears, asking if you want to apply these report settings to the

most recent set of reports.

- To apply the settings to the most recent reports, click Yes.  The report settings screen

closes, and the patient record screen appears, where you can view and print the updated

reports.

The new Report Settings have been applied to the most recent study. You can then click

any of the reports for the most recent study to view and print one of them, or click Print

All to print all of the reports.

- To save the Report Settings for the patient but not apply them to any studies yet, click No.

If you want to apply the new Report Settings for the patient to one or more studies, find

the study on the patient record screen and select Regenerate reports  from the Other

Options  drop-down list. The reports are re-generated using the new Reports Settings.
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Restoring the default report settings

If you want to set a patient’s report settings to the current default settings for your clinic, you can

do this in the Patient Report Settings. You will then have the option to choose which of the patient's

studies you want to show the changes to the report settings.

1 Click the Edit  link in the Patient Report Settings section of the patient record screen.

The patient’s General Report Settings and Analysis Reports Settings are displayed.

2 Click the Restore defaults button on the patient’s report settings screen.

3 Click Save.  A small window appears, asking if you want to apply these report settings to the

most recent set of reports.

- To apply the settings to the most recent reports, click Yes.  The report settings screen

closes, and the patient record screen appears, where you can view and print the updated

reports.

The new Report Settings have been applied to the most recent study. You can then click

any of the reports for the most recent study to view and print one of them, or click Print
All to print all of the reports.

- To save the Report Settings for the patient but not apply them to any studies yet, click No.

If you want to apply the new Report Settings for the patient to one or more studies, find

the study on the patient record screen and select Regenerate reports  from the Other
Options  drop-down list. The reports are re-generated using the new Reports Settings.

Generating a Data Table report

If necessary, you can generate a Data Table report (about 15 pages or more). This report lets you

view detailed sensor glucose readings, and events that are recorded in the Logbook. The Data Table

is used by Medtronic employees for troubleshooting purposes. Most of the time, you do not need

it in order to understand a study.

1 In the patient record screen, select Generate Data Table from the Other Options  drop-down

list.

After a few moments, a new Data Table  PDF link appears.

2 Click the link to view the report. The report opens in a new browser window or tab.

Or, click Print  to print the report without viewing it first.
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Exporting data to CSV file

If necessary, you can export report data as a character-separated values (CSV) file for further

analysis. A CSV export is raw data, typically for clinical study use. Additional information in the data

is used by Medtronic employees for troubleshooting purposes. Most of the time, you do not need

it in order to understand a study.

1 In the patient record screen, select Export data from the Other Options  drop-down list.

After a few moments, a dialog box opens, allowing you to save the file on the computer.

2 Save the file on your computer or network. You can now open the file directly, for example, in

Microsoft® Excel® or Access®.
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5

Pattern Snapshot report

Key Notes:

• The Pattern Snapshot report displays general statistics, observed patterns and some possible

causes, and an overlay graph.

• General statistics includes Avg SG, Estimated A1C, and Time in range.

• The Pattern Snapshot report displays up to three observed patterns.

• The Overlay graph displays information gathered from the study period.
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Overview of the Pattern Snapshot report

The Pattern Snapshot report displays general statistics, observed patterns and some possible

causes, and an overlay graph.

-

X

X X

1 23

General statistics

This section of the Pattern Snapshot report shows general statistics, including Avg SG (average

sensor glucose value), Estimated A1C (glycosylated hemoglobin), and Time in range.
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Item Description

Avg SG
Avg SG is the average of all SG values during the current study. If this patient has a
previous study in CareLink iPro software, the most recent previous Avg SG will also
be displayed.

Estimated A1C

Estimated A1C is an estimated measurement of glycosylated hemoglobin. Estimated
A1C does not replace the lab measurement of A1C and is calculated from limited SG
data, from the current study.

Formula:

A1C = (Avg SG + 46.7) / 28.7

Time in range Time in range displays the percentage of time the patient is above, below, or within
the high or low thresholds set in clinic settings, during the study.

Observed patterns and some possible causes

Observed patterns

The Pattern Snapshot report displays up to three observed patterns. The pattern title consists of

glycemic issues and an analysis period in which the issue was observed.

NOTE: Time periods in between the selected time ranges will not be analyzed.

During a study, if there are at least two days with meal markers occurring in a meal period, pre-

meal and post-meal analysis is performed, otherwise an analysis is performed for the time period.

When pre-Breakfast analysis cannot be performed because there are not at least two meal markers

during the Breakfast period, then the Fasting period is used for analysis in addition to Breakfast time

period.

• Post meal analysis period is based on patient settings.

• Pre-meal analysis period is fixed and it is the hour immediately prior to the meal marker.
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Data elements displayed

Priority number The priority number corresponds to the priority of the pattern and its location on the
SG graph. Up to three patterns may be shown.

Pattern heading

The pattern heading displays the SG pattern and corresponding time period. SG
patterns will be High, Low, Variable with Low, or Variable. Time periods are defined
by meal times, such as Breakfast, Lunch, and Dinner. For more information on time
periods, see Analysis Reports Settings on page 9.

NOTE: Overnight time is the combination of Evening and Sleeping
time periods.

Line 1

For High SG and Low SG patterns, Line 1 displays the number of days out of the
number of evaluation days an excursion or SG variability was observed. The
evaluation days are different than study days. For example, fasting may only be seen
on two days out of the three days study.

For Variable SG and Variable SG with Low SG patterns, Line 1 displays the number of
days excursions occurred within the time range relevant to the pattern and sensor
glucose range (extreme low to low).

Line 2

For High SG and Low SG patterns, Line 2 displays the number of days excursions
occurred within the time range relevant to the pattern and sensor glucose range
(extreme low to low or high to extreme high).

For Variable SG and Variable SG with Low SG patterns, Line 2 displays the number of
days excursions occurred below the extreme low limit.

Line 3

For High SG and Low SG patterns, Line 3 displays the number of days excursions
occurred above or below an extreme low or extreme high and the SG range (extreme
low or extreme high).

For Variable SG and Variable SG with Low SG patterns, Line 3 displays the number of
days excursions occurred above the high limit.

Some possible causes For a list of some possible causes, see Some possible causes on page 38.
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Some possible causes

The tables in this section list the causes that will be shown with each SG pattern observed.

NOTE: The causes listed are not a complete list of all possible causes and some causes may not
apply. Healthcare professionals should use best judgment on other causes that might be
relevant.

Low SG – Overnight

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in evening(s) too high?

Insulin to carbohydrate ratio not optimal in prior evening(s)?

Less food intake in prior evening(s)?

More exercise in prior evening(s)?

Alcohol consumed in prior evening(s)?

High SG – Overnight

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injection in evening(s) too low?

Insulin to carbohydrate ratio not optimal in prior evening(s)?

High calorie or high fat foods in prior evening(s)?

Late evening snack?

Variable SG – Overnight

Inconsistent food intake day before?

Inconsistent exercise schedule day before?

Inconsistent sleep pattern?

Oral medication(s) day before missed or incorrectly timed?

Basal insulin injection missed?

Pre-meal insulin in prior evening(s) incorrectly timed or missed?

Variable SG with Low SG - Overnight

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in evening(s) too high or missed?

Pre-meal insulin in prior evening(s) incorrectly timed or incorrect dose?

Inconsistent food intake day before?

Inconsistent exercise schedule day before?

Alcohol consumed in prior evening(s)?
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Low SG - Pre-breakfast*

Oral medication(s) too high or incorrectly timed in evening(s)?

Basal insulin injection in evening(s) too high?

Less food intake in prior evening(s)?

Breakfast delayed?

More exercise in prior evening(s)?

Alcohol consumed in prior evening(s)?

Low SG - Post-breakfast*

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in evening(s) too high?

Pre-breakfast insulin too high?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Less food intake than usual?

Exercised around breakfast?

Low SG - Breakfast

Oral medication(s) too high or incorrectly timed in evening(s)?

Basal insulin injections too high?

Pre-breakfast insulin too high?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Delayed or less food intake than usual?

Exercised around breakfast?

High SG - Pre-breakfast*

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injection in evening(s) too low?

Rebound hyperglycemia after nocturnal hypoglycemia?

High calorie or high fat foods in prior evening(s)?

Late evening snack?

High SG - Post-breakfast*

Oral medication(s) missed, too low, or incorrectly timed?

Pre-breakfast insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

High calorie or high carbohydrate foods?
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High SG - Breakfast

Oral medication(s) missed, too low, or incorrectly timed?

Pre-breakfast insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

High calorie or high carbohydrate foods?

Variable SG - Pre-breakfast*

Inconsistent food intake day before? Breakfast time not consistent?

Inconsistent exercise schedule day before?

Inconsistent sleep pattern?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Basal insulin injection missed?

Alcohol consumed in prior evening(s)?

Variable SG with Low SG - Pre-breakfast*

Oral medication(s) too high or incorrectly timed in evening(s)?

Basal insulin injection in evening(s) too high or missed?

Inconsistent food intake day before?

Breakfast time not consistent?

Inconsistent exercise schedule day before?

Alcohol consumed in prior evening(s)?

Variable SG - Post-breakfast*

Inconsistent food intake?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-breakfast insulin incorrectly timed, incorrect dose, or missed?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Variable SG with Low SG - Post-breakfast*

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in evening(s) too high or missed?

Pre-breakfast insulin incorrectly timed or incorrect dose?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Inconsistent food intake?

Exercised around breakfast time?

CareLink iPro Software — User Guide   Pattern Snapshot report 40



Variable SG - Breakfast

Inconsistent food intake?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-breakfast insulin incorrectly timed, incorrect dose, or missed?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Variable SG with Low SG - Breakfast

Oral medication(s) too high or incorrectly timed in evening(s)?

Basal insulin injection in evening(s) too high or missed?

Pre-breakfast insulin incorrectly timed, incorrect dose, or missed?

Insulin to carbohydrate ratio not optimal for pre-breakfast insulin?

Inconsistent food intake?

Exercised around breakfast time?

Low SG - Fasting

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in evening(s) too high?

Less food intake in prior evening(s)?

Breakfast delayed?

More exercise in prior evening(s)?

Alcohol consumed in prior evening(s)?

High SG - Fasting

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injection in evening(s) too low?

Rebound hyperglycemia after nocturnal hypoglycemia?

High calorie or high fat foods in prior evening(s)?

Late evening snack?

Variable SG - Fasting

Inconsistent food intake day before? Breakfast time not consistent?

Inconsistent exercise schedule day before?

Inconsistent sleep pattern?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Basal insulin injection missed?

Alcohol consumed in prior evening(s)?
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Variable SG with Low SG - Fasting

Oral medication(s) too high or incorrectly timed in evening(s)?

Basal insulin injection in evening(s) too high or missed?

Inconsistent food intake day before?

Breakfast time not consistent?

Inconsistent exercise schedule day before?

Alcohol consumed in prior evening(s)?

Low SG - Pre-lunch*

Oral medication(s) too high or incorrectly timed?

Basal insulin injections in morning(s) too high?

Lunch delayed?

Exercised before lunch?

Low SG - Post-lunch*

Oral medication(s) too high or incorrectly timed?

Basal insulin injections in morning(s) too high?

Pre-lunch insulin too high?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

Less food intake than usual?

Exercised around lunch?

Low SG - Lunch

Oral medication(s) too high or incorrectly timed?

Basal insulin injections too high?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

Less food intake than usual?

Lunch delayed?

Exercised around lunch?

High SG - Pre-lunch*

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injections too low?

Pre-lunch insulin incorrectly timed, too low, or missed?

High calorie or high carbohydrate in prior meal?

Previous meal delayed or snacking?
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High SG - Post-lunch*

Oral medication(s) missed, too low, or incorrectly timed?

Pre-lunch insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

High calorie or high carbohydrate foods?

High SG - Lunch

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injections too low?

Pre-lunch insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

High calorie or high carbohydrate in prior/current meal?

Previous meal delayed or snacking?

Variable SG - Pre-lunch*

Occasional snack between meals?

Inconsistent meal schedule or meal size?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-meal insulin for prior meal(s) incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

Variable SG with Low SG - Pre-lunch*

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in morning(s) too high or missed?

Pre-meal insulin for prior meal(s) incorrectly timed, dosed, or missed?

Inconsistent meal/snack schedule or size?

Inconsistent exercise in morning(s)?

Variable SG - Post-lunch*

Inconsistent food intake?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-lunch insulin incorrectly calculated?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?
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Variable SG with Low SG - Post-lunch*

Oral medication(s) too high or incorrectly timed?

Pre-lunch insulin incorrectly timed or incorrect dose?

Insulin to carbohydrate ratio not optimal for pre-lunch insulin?

Inconsistent food intake?

Exercised around lunch time?

Variable SG - Lunch

Occasional snack between meals?

Inconsistent meal schedule or meal size?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-meal insulin for prior meal(s) incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-meal insulin?

Variable SG with Low SG - Lunch

Oral medication(s) too high or incorrectly timed in morning(s)?

Basal insulin injection in morning(s) too high or missed?

Pre-meal insulin for prior meal(s) incorrectly timed, dosed, or missed?

Inconsistent meal schedule or meal size?

Exercised around lunch time?

Low SG - Pre-dinner*

Oral medication(s) too high or incorrectly timed?

Basal insulin injections too high?

Dinner delayed?

Exercised before dinner?

Low SG - Post-dinner*

Oral medication(s) too high or incorrectly timed?

Basal insulin injections too high?

Pre-dinner insulin too high?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

Less food intake than usual?

Exercised around dinner?
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Low SG - Dinner

Oral medication(s) too high or incorrectly timed?

Basal insulin injections too high?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

Less food intake than usual?

Dinner delayed?

Exercised around dinner?

High SG - Pre-dinner*

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injections too low?

Pre-dinner insulin incorrectly timed, too low, or missed?

High calorie or high carbohydrate in prior meal?

Previous meal delayed or snacking?

High SG - Post-dinner*

Oral medication(s) missed, too low, or incorrectly timed?

Pre-dinner insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

High calorie or high carbohydrate foods?

High SG - Dinner

Oral medication(s) missed, too low, or incorrectly timed?

Basal insulin injections too low?

Pre-dinner insulin incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

High calorie or high carbohydrate in prior/current meal?

Previous meal delayed or snacking?

Variable SG - Pre-dinner*

Occasional snack between meals?

Inconsistent meal schedule or meal size?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-meal insulin for prior meal(s) incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?
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Variable SG with Low SG - Pre-dinner*

Oral medication(s) too high or incorrectly timed?

Basal insulin injection in morning(s) too high or missed?

Pre-meal insulin for prior meal(s) incorrectly timed, dosed, or missed?

Inconsistent meal/snack schedule or size?

Inconsistent exercise in morning(s)?

Variable SG - Post-dinner*

Inconsistent food intake?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-dinner insulin incorrectly calculated?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

Variable SG with Low SG - Post-dinner*

Oral medication(s) too high or incorrectly timed?

Pre-dinner insulin incorrectly timed or incorrect dose?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

Inconsistent food intake?

Exercised around dinner time?

Variable SG - Dinner

Occasional snack between meals?

Inconsistent meal schedule or meal size?

Oral medication(s) intermittently missed, too low, or incorrectly timed?

Pre-meal insulin for prior meal(s) incorrectly timed, too low, or missed?

Insulin to carbohydrate ratio not optimal for pre-dinner insulin?

Variable SG with Low SG - Dinner

Oral medication(s) too high or incorrectly timed in morning(s)?

Basal insulin injection in morning(s) too high or missed?

Pre-dinner insulin incorrectly timed, incorrect dose, or missed?

Inconsistent meal schedule or meal size?

Exercised around dinner time?

*Patterns with sufficient meal markers.
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Sensor data graph

The Overlay graph displays information gathered from the study period.

overlay 
graph

a b

d

c

Item Description

a
Priority number indicators for the patterns listed in the Observed patterns & some
possible causes section. The horizontal lines indicate the period of the observed
pattern (for example, Breakfast).

b Average SG values are displayed for every 3 hour periods.

c

Solid colored lines trace daily SG values. The dotted line traces the Avg SG for the
study period. Open circles on the plot lines represent meal markers.

NOTE: Meal markers are plotted on the SG trace line for the day

they occur and may not be at the BG value recorded for that
marker.

d Light green band represents the target range as defined by the High and Low
Glucose Target Range in Patient Report Settings.
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6

CareLink iPro software ongoing use

Key Notes:

• Click the Resources  hyperlink in CareLink iPro software to print the newest log sheets and other

forms.

• Only administrative users can add, modify, and delete CareLink iPro software user accounts.

Always make sure more than one person has administrative privileges.

• Any CareLink iPro software user can edit patient information when needed.
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User tasks

Printing more log sheets and other forms

Your original iPro2 system shipment may have included samples of Patient Log Sheets, Clinic

Equipment Logs, and other documents that your clinic wants to use regularly. You can easily

download and print more of these documents.

1 Click the Resources  link at the bottom of the CareLink iPro software screen.

2 Find the document that you want and open it.

3 Select the print option in your browser.

Changing your password or other user information

As a CareLink iPro software user, you can change your own password, email address, and other

information in your user account.

1 Sign in to CareLink iPro software.

2 Click the My Info  link. The My Info screen is displayed.

3 If you want to change your password, select the Change Password  check box. The password

fields become active. Type your new password in the Password  field, and re-type it in the Re-
enter Password  field.

4 Modify the other information as needed.

5 Click the Save button. If you changed your password, use your new password the next time

you sign in.

Editing patient information

You may occasionally need to update patient information, such as the patient's name, therapy

type, or physician. Any user can update any patient's information for your clinic.

1 On the patient record screen, click the Edit patient information link.

2 Update the patient's information as needed.

3 Click the Save button. The changes have been saved, and any information that shows up on

reports will be updated the next time you generate reports for the patient.
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Moving a patient study

If you accidentally upload a study to the wrong patient record in CareLink iPro software, you can

move the study to the correct patient record.

Use the Clinic Equipment Log if needed, to help you find the dates when each patient wore the

iPro2 recorder.

1 Confirm that the patient whose study was uploaded incorrectly has been added to CareLink

iPro software. If the patient record does not exist yet, you need to create it now. For details,

see Opening the patient record on page 21.

2 After you have confirmed that the correct patient exists in the system, open the patient record

that contains the study that needs to be moved.

3 Find the study that you want to move in the list of studies for that patient.

4 If you see a message that the study is incomplete, enter the patient's BG meter readings by

uploading the meter or using the Logbook.

5 In the Other Options  drop-down list, select Move this study.

6 Follow the on-screen instructions to find the correct patient and move the study to that patient's

record.

When the move is complete, the reports will be regenerated for the correct patient.

Modifying clinic information

You may periodically need to edit the identifying information of the clinic that was entered when

the clinic account was first created. Some of this information appears on patient reports, so it is

important to keep the clinic information accurate.

1 In the Clinic Settings  tab, click Clinic Information.  The clinic information is displayed.

If you do not see the Clinic Settings  tab, click the Home tab. You should now see the Clinic
Settings  tab.

2 Update the information as needed and click the Save button.

3 When you are finished, click Close clinic settings  to return to the Patient List.
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Administrator tasks

If you are an administrative user, you will need to create, modify, or delete CareLink iPro software

user accounts for your clinic as needed. For details on creating user accounts, see Create user

accounts on page 7.

Modifying user accounts

If you have administrative privileges, you can modify a user account. For example, you may need

to change a user password, or grant or remove administrative privileges.

1 In the Clinic Settings tab, click Users.  The existing user accounts are displayed.

2 Select the user account and click the Open user  button. The user account information appears.

3 If you want to edit the user account information, such as the password, enter the information

and click the Save button.

Deleting user accounts

If you have administrative privileges, you can delete a user account. You need to delete user

accounts for users who no longer should have access to CareLink iPro software for your clinic, so

that they can no longer access patient records.

1 In the Clinic Settings tab, click Users.  The existing user accounts are displayed.

2 Select the user account and click the Open user  button. The user account information appears.

3 If you want to delete the user account, click the Delete User button.

4 In the confirmation screen, click Yes.
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A

Troubleshooting

This appendix contains troubleshooting information for the CareLink iPro Therapy Management

Software for Diabetes. Please refer to these instructions before contacting the 24 Hour HelpLine.

Troubleshooting reference

Problem Possible causes What to do

The reports only show a
partial study. Data ends
before study was supposed
to end.

A common cause of a
partial study is sensor
pullout.

If the sensor was not
pulled out, the iPro2
recorder battery may not
have had sufficient power
to complete the study.
CareLink iPro software
checks the battery and
displays a message during
the upload process to warn
you that there might be a
problem:

The iPro2 Recorder
battery is not charging
properly. Please refer to
the User Guide for
assistance.

Also, the Dock displays a
solid red warning light
when there may be a
problem with the iPro2
recorder battery.

• If the sensor pulled out, make sure that the
sensor is fully inserted and properly taped to
the skin for future studies.

• If you did not see an error message in CareLink
iPro software during the uploading process, it
could be that there are not enough BG meter
readings for calibration after a certain point in
the study.

Make sure that you have entered all of the
patient's BG meter readings into CareLink iPro
software. CareLink iPro software needs good BG
meter readings in order to calibrate sensor
data. Less than three BG meter readings per
day, or more than 12 hours between BG meter
readings, can result in data gaps.

• If you saw a CareLink iPro software error
message, see the troubleshooting steps for that
error message in this section.
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Troubleshooting reference

Problem Possible causes What to do

There are gaps in the
sensor data in the reports.

A common cause of data
gaps is partial sensor
pullout.

There can also be
calibration problems due
to an insufficient number
of BG meter readings,
readings that are more
than 12 hours apart, or
readings that are out of
the expected range.

Make sure that you have entered all of the patient's
BG meter readings into CareLink iPro software.
CareLink iPro software needs good BG meter
readings in order to calibrate and report sensor
data. Less than three per day can result in data
gaps.

Also check the sensor trace on reports to see if
there are BG meter readings not used for
calibration. Bad BG meter readings are identified as
calibration errors. These BG meter readings are not
used for calibration and cause the sensor plot to
stop. The sensor plot starts again at a good BG
meter reading. You can eliminate some data gaps
by excluding bad BG meter readings using the
Exclude feature in the Logbook.

Some sensor pullouts can be avoided by applying
an adhesive dressing over the iPro2 recorder and
sensor.

Always advise patients to test their blood glucose
at least four times a day.

I uploaded the wrong
meter for a patient. Can I
fix this?

In the Logbook screen, check the Exclude  check
box to exclude all of the BG meter readings that
came from the wrong meter. The readings from the
wrong meter will still  be in the Logbook, but they
will not affect sensor calibration or reports. If you
find the right meter or log sheets for the patient,
you can manually enter the BG meter readings from
the right meter.

Also, you can still upload the meter to the correct
patient study.

I uploaded the wrong
study for a patient. Can I
fix this?

Yes, you can move the entire study from the
incorrect patient record to the correct patient
record. For details, see Moving a patient study on
page 50.
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CareLink iPro software messages

CareLink iPro software error messages

Problem Possible causes What to do

CareLink iPro software
displayed this message
during the upload process:

iPro2 Docking Station not
found. Please connect the
iPro2 Docking Station to
the computer.

A Dock is not connected to
the computer, it is not
securely connected, or it
has insufficient power from
the computer to operate.

If the white Dock power light is on, then the USB
cable may not be securely connected. Make sure
that the cable is plugged in all the way to the Dock
and to the computer.

If the white Dock power light is not on, try
connecting the Dock to a different USB port on the
computer. Wait for all three lights to flash, followed
by a solid white light. If the Dock is connected to
the computer but none of the lights turn on, there
may be other USB devices connected that are using
up power. Disconnect other devices. Do not
connect more than one Dock at a time to a
computer.

If you are using a USB hub, it may not be receiving
enough power for the Dock to operate. Try using a
powered hub, which has its own electrical plug that
connects to an electrical socket.

CareLink iPro software
displayed this message
during the upload process:

Device not found in iPro2
Docking Station. Please
connect iPro2 Recorder.

The iPro2 recorder is not in
the Dock, or it is not
properly connected. This
message may also appear if
the iPro2 recorder
connector pins are
damaged or corroded, or if
there is moisture in the
connector opening.

If your iPro2 recorder is connected, try
disconnecting and reconnecting the iPro2 recorder
to the Dock.

If the white Dock power light is on, but the three
lights do not flash when you connect the iPro2
recorder, the iPro2 recorder may be damaged.
Check the iPro2 recorder connector pins for
moisture, damage, or corrosion. For assistance in
locating the connector pins, see the iPro2 System
User Guide.

If the iPro2 recorder pins are damaged or corroded,
the iPro2 recorder cannot communicate with the
Dock or CareLink iPro software. Contact the 24 Hour
HelpLine. It may be time to replace the iPro2
recorder.

CareLink iPro software
displayed this message
during the upload process:

iPro2 Recorder is not
responding. Please
confirm the connected
device is an iPro2
Recorder and try again.

The red warning light on
the Dock is on.

!!!!!

The Dock only works with iPro2 recorders. You may
be trying to upload the wrong device. The iPro2
recorder has an "i" on the front of it.

If you are sure that the device is an iPro2 recorder,
it may not be properly connected. Try
disconnecting the iPro2 recorder from the Dock and
then reconnecting it.

If the problem continues, check the iPro2 recorder
connector pins for moisture, damage, or corrosion.
For assistance in locating the connector pins, see
the iPro2 System User Guide. If the pins are
damaged or corroded, contact the 24 Hour
HelpLine. It may be time to replace the iPro2
recorder.

If the iPro2 recorder connector pins are not
damaged, the iPro2 recorder may need to be reset.
For instructions, see the iPro2 System User Guide.
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CareLink iPro software error messages

Problem Possible causes What to do

CareLink iPro software
displayed this message
during the upload process:

The iPro2 Recorder
battery is not charging
properly. Please refer to
the User Guide for
assistance.

The red warning light on
the Dock is on.

!!!!!

The iPro2 recorder battery
may be reaching the end
of its life. However, this
message may also appear if
the iPro2 recorder
connector pins are
damaged or corroded, or if
there is moisture in the
connector opening.

Disconnect the iPro2 recorder and reconnect it to
the Dock. Allow the iPro2 recorder to charge for 20
minutes. The green charging light may flash at first,
but if the red warning light turns on again, check
the iPro2 recorder connector pins for moisture,
damage, or corrosion. For assistance in locating the
connector pins, see the iPro2 System User Guide.

If the red warning light continues to turn on,
perform a reset as described in the iPro2 System
User Guide. Please note that if you saw this error
message in CareLink iPro software, the recent
patient data was successfully uploaded, but you
may wish to confirm this before performing the
reset. If the Dock displays a solid green charging
light, the reset was successful.

If the iPro2 recorder connector pins are damaged or
corroded, or the Dock still displays a red warning
light for the iPro2 recorder after the reset, contact
the 24 Hour HelpLine. It may be time to replace the
iPro2 recorder.

CareLink iPro software
displayed this message
during the upload process:

Possible damage to iPro2
Recorder circuitry. Please
refer to the User Guide
for assistance.

The red warning light on
the Dock is on.

!!!!!

There may be moisture,
damage, or corrosion in
the iPro2 recorder
connector opening, or the
iPro2 recorder may need to
be reset.

Disconnect the iPro2 recorder and reconnect it to
the Dock. Charge the iPro2 recorder for 20 minutes.
If the Dock displays a solid green charging light, the
reconnection was successful.

If the green charging light flashes at first, and then
the red warning light turns on, check the iPro2
recorder connector pins. For assistance in locating
the connector pins, see the iPro2 System User
Guide.

If you do not find any problems inside of the
connector opening, and the green charging light
never remains on without flashing when you
connect the iPro2 recorder to the Dock, perform a
reset as described in the iPro2 System User Guide,
and charge the iPro2 recorder for one hour. Please
note that if you saw this error message in CareLink
iPro software, the recent patient data was
successfully uploaded, but you may wish to confirm
this before performing the reset. If the Dock
displays a solid green charging light, the reset was
successful.

If the red warning light continues to turn on,
contact the 24 Hour HelpLine. It may be time to
replace the iPro2 recorder.

CareLink iPro Software — User Guide   Troubleshooting 55



CareLink iPro software error messages

Problem Possible causes What to do

CareLink iPro software
displayed this message
during the upload process:

Transfer failed: An
unrecoverable data error
has been detected in the
device's data. Please refer
to the User Guide for
assistance.

The data on the iPro2
recorder cannot be
recovered. CareLink iPro
software cannot complete
the data upload. There may
be a problem with the
device.

Contact the 24 Hour HelpLine for assistance. You
may be instructed to reset the iPro2 recorder.
Please note that resetting the iPro2 recorder erases
all data from the iPro2 recorder.

CareLink iPro software
displayed this message
during the meter upload
process:

An unrecoverable data
error has been detected
in the device's data.
Please refer to the User
Guide for assistance.

This message is different
from the message above. It
appears when CareLink
iPro software cannot
complete the meter data
upload.

Enter the BG meter readings manually using the
Logbook screen in CareLink iPro software.
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Glossary

Area Under the Curve (AUC) - Indicates the amount in high and low excursions as determined by
preset values. Excursion data indicates the frequency of highs or lows. AUC indicates the
magnitude of events by showing how far out of range and for how long.

BG - Blood Glucose

BG reading - Blood glucose measurement that is taken by a blood glucose meter.

Calibrate - Check, adjust, or set to a standard. Sensor data is calibrated using BG meter readings.

Docking station (Dock) - Device that performs two functions: uploading glucose sensor data from an
iPro2 recorder to CareLink iPro software; and charging the iPro2 recorder. The Dock can be
connected to a computer or to an electrical socket.

iPro2 digital recorder (iPro2 recorder) - Device that continuously records sensor glucose data while
connected to a glucose sensor. You can upload the data to CareLink iPro software by connecting
the iPro2 recorder to a Dock, and view the sensor data on reports.

Logbook - A screen in CareLink iPro software that lets you manually enter events such as BG meter
readings, meals, exercise, and medication taken, so that these events show up on reports. The
Logbook also displays BG meter readings, and possibly other events, that you upload from a
supported blood glucose meter into CareLink iPro software.

Mean Absolute Difference % (MAD%) - Represents the level of accuracy in calibration of the sensor
to BG meter readings. The lower this number, the greater the calibration accuracy. MAD% is
calculated by taking the difference between closely occurring pairs of sensor glucose and BG meter
readings, dividing by the BG meter reading, and then averaging across all pairs.

Mean Absolute Difference (MAD) - Represents the level of accuracy in calibration of the sensor to BG
meter readings. The lower this number, the greater the calibration accuracy. MAD is calculated by
taking the difference between closely occurring pairs of sensor glucose and BG meter readings and
then averaging across all pairs.

Meter - A medical device for determining the approximate concentration of glucose in the blood. A
small drop of blood is placed on a disposable test strip, which the meter reads and uses to calculate
the blood glucose level. The meter then displays the level in mg/dL or mmol/L.

Study - The period of time that a patient wears a glucose sensor and iPro2 recorder. This word also
refers to an upload of glucose sensor data from an iPro2 recorder into CareLink iPro software, along
with any meter upload and Logbook entries for that iPro2 recorder upload. Each study has its own
set of reports.

Upload - The process of transferring diabetes device data to the CareLink iPro software.
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